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Abstract

In the turning process, all the energy used for chip formation is converted into heat. This causes the
temperature at the cutting zone will increase. The heat generated during the machining process depends on the
type of tool material, workpiece material, and process parameters such as cutting speed, cutting depth and
feeding. High temperatures that are well distributed during the turning process, have an important effect on the
tension on the tools. Therefore, it is necessary to analyze the effect of variation of the rake angle on titanium
machining process, by comparing the theoretical and simulation results using Autodesk Inventor 2016. In this
research, the cutting force used was orthogonal. The main angle variations are used 5°, 10° and 15°. Based on
the theoretical, the maximum cutting force (Fc) is 1720 N for the rake angle (y) 5°, and there is a decrease in the
cutting force of each rake angle (y) increase. From the simulation results, the maximum tension occurs at a rake
angle of 15°, amounting to 1368.462 N / mm?2. There is an increase in the tension of each rake angle (y) increase.

Keywords: orthogonal cutting, temperature distribution, thermal stress

Abstrak

Pada proses bubut, seluruh energi yang digunakan untuk pembentukan geram diubah menjadi kalor.
Hal ini menyebabkan suhu pada zona pemotongan akan meningkat. Kalor yang dibangkitkan selama proses
pemesinan bergantung terutama pada jenis pahat, material benda kerja, dan parameter proses seperti kecepatan
potong, kedalaman potong dan gerak makan. Temperatur tinggi yang terdistribusi dengan baik selama proses
pembubutan, memiliki pengaruh yang penting terhadap tegangan pada mata pahat. Maka dari itu perlu
dilakukan analisa pengaruh sudut geram terhadap tegangan pada proses pembubutan titanium dengan cara
mengkomparasi hasil teoritis dan simulasi menggunakan Autodesk Inventor 2016. Pada penelitian ini, gaya
pemotongan yang digunakan adalah pemotongan orthogonal. Variasi sudut utama pemotongan yang digunakan
5", 10" dan 15°. Berdasarkan dari perhitungan secara teoritis, gaya potong maksimum (F,) yaitu 1720 N untuk
sudut geram (y) 5° dan terjadi penurunan gaya potong setiap kenaikan sudut geram (y). Dari hasil simulasi
yang dilakukan, tegangan maksimum terjadi pada sudut potong 15°, sebesar 1368,462 N/mm’ | terjadi kenaikan
tegangan setiap kenaikan sudut geram (y) .

Kata Kunci : pemotongan orthogonal, distribusi temperature, tegangan thermal

merupakan informasi yang sangat penting dalam

LATAR BELAKANG .

perencenaan pemesinan. Gaya pemotongan faktor
Proses Turning adalah proses pemesinan pada yang sangat diperhitungkan dalam menganalisa dan
permukaan benda kerja yang menghasilkan geometri mengembangkan perangkat untuk mendapatkan gaya
silinder. kenaikan temperature pada kontak pahat dan potong. Hal ini yang kemudian menimbulkan
benda kerja adalah salah satu parameter penting pada tegangan yang terjadi antara pahat potong dan juga

analisa proses turning. Temperatur pemotongan benda kerja [2].
timbul akibat panas yang dihasilkan oleh deformasi Keausan pahat dapat dipengaruhi geometri
material dari perautan benda kerja, gesekan antara pahat, selain itu juga dipengaruhi oleh faktor - faktor
pahat dan benda kerja dan gesekan antara pahat dan proses pemesinan antara lain jenis bahan benda kerja
geram [1]. dan pahat, kondisi (parameter) pemotongan
Dalam proses pemesinan, suhu pemotongan (kecepatan potong, kedalaman pemotongan, dan
dan gaya pemotongan merupakan parameter penting gerak makan), cairan pendingin, dan jenis dari proses
yang harus dikontrol atau dikurangi. Suhu pemesinan [3]. Saat proses pembubutan, kecepatan
pemotongan dan gaya pemotongan akan berpengaruh potong, gerak makan, dan kedalaman pemotongan
terhadap umur pahat sehingga mempengaruhi biaya akan mempengaruhi besarnya tegangan yang terjadi
produksi (cost). Besarnya gaya pemotongan pada proses pemotongan. Makin besar gaya potong

maka akan memperbesar suhu kontak antara benda
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kerja dengan mata pahat. Hal ini dapat membuat
pahat lebih cepat mengalami keausan. Dengan
begitu, besaran gaya potong ataupun tegangan pada
proses pembubutan menjadi penting untuk diketahui.
Perhitungan tegangan didapatkan dengan cara
mengukur gaya pemotongan mesin bubut nantinya
dapat digunakan untuk mengoptimalkan proses
pemesinan di mesin bubut [4].

METODE PENELITIAN

Gambar 1 dan Gambar 2 menunjukkan tata alir
pelaksanaan penelitian dan simulasi yang dilakukan.
Sebelum melaksanakan penelitian, terlebih dahulu
dilakukan simulasi menggunakan software inventor

Szmslasi Prases Pam bubstan Totanizn
damges Fois Antsdas: Invenssr 2018

Gambar 1 Diagram Alir Simulasi.

Finite Element Analysis adalah suatu cara untuk
mendapatkan hasil eksperimen yang mendekati
situasi atau keadaan yang sebenarnya dengan bantuan
dengan bantuan komputer, dimana dalam melakukan
penelitian ini menggunakan bantuan Sofiware
Autodek Inventor 2016.

Gambar 2 Diagram Alir Penelitian
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Tabel 1 menunjukan kondisi batas yang ditentukan
berdasarkan beberapa penelitian sebelumnya. Hal ini
dilakukan untuk mendapatkan hasil yang baik dalam
rentang kondisi tertentu.

Tabel 1. Kondisi Batas Pemesinan

Kondisi
Batas Deskripsi
Penelitian
Cutting Speed, V. (m/min) =
Parameter 350
Pemesinan Feed Rate, F,(mm/rev) = 0.10
Depth of cut, d (mm) = 1 mm
Pendingin SCCO,
Pahat Tools = Uncoated Carbide
Rake Angle = 5°,10°, 15°
Temperature = -80°
Chamber pressure = 10.34 MPa
Parameter .
S Nozzle distance = 8 mm
Pendingin

Nozzle angle = 45°
Lubricant flow rate = 2.61 1/hr

Dy amomeler

.
FLIR Thermal Imager

Gambar 3. Kondisi pemesinan [2]

Langkah-langkah Analisis

Finite Element Analysis merupakan adalah
suatu cara untuk mendapatkan hasil eksperimen yang
mendekati situasi atau keadaan yang sebenarnya
dengan bantuan dengan bantuan komputer, dimana
dalam melakukan penelitian ini menggunakan
bantuan Software Autodek Simulation Mechanical
2016. Tahapan-tahapan tersebut dapat diuraikan
sebagai berikut:

1. Pembuatan model prakiraan simulasi proses
pembubutan titanium menggunakan Autodesk
Inventor 2016 perlu mempertimbangkan
beberapa parameter, seperti geometri dan sifat
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mekanik pahat dan benda kerja serta beban yang
diberikan berupa gaya potong yang timbul pada
sudut kontak antara pahat dan benda kerja.

Gambar 4. Pembuatan Model Prakiraan Simulasi
Menggunakan Autodesk Inventor 2016

2. Penentuan kondisi batas dilakukan setelah model
prakiraan diberikan beban kerja. Dalam
penulisan ini kondisi batas yang diberikan adalah
kondisi pemesinan pada proses pembubutan
titanium.

Gambar 5. Tampilan Mesh view dan batas kondisi
prakiraan simulasi menggunakan Autodesk
Simulation Mechanical 2016

3. Hasil yang didapatkan pada penelitian ini berupa
grafik tegangan yang terjadi pada proses
pemesinan titanium.

4. Tahapan terakhir adalah melakukan validasi
hasil simulasi dengan hasil eksperimen.

HASIL DAN PEMBAHASAN

Parameter Pemesinan

Parameter pemesinan yang digunakan pada
proses simulasi ini mengacu pada penelitian yang
telah dilakukan oleh (Rahim et al. 2016) seperti
ditunjukan pada Tabel 1
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Data Hasil Perhitungan

Adapun data simulasi pemotongan seperti
ditunjukan pada bab sebelumnya, dapat ditentukan
menggunakan persamaan, sehingga didapatkan hasil
sebagai berikut (Tabel 2).

Tabel 2. Data hasil perhitungan

Rake Angle 5° 10 15
Shear Angle 43 40 37
@
Chip 08635mm| 0.7422mm | 0.6490 mm
Thickness
Ratio
2 11554 mm| 13473 mm | 1.5408 mm
Shear Strain 1.8533 1.769 1.731
Shear Force 111437 118233 1262.84
E)
Cutting Force | 172073 N | 130004 N | 1321.172N
(Fey

Pemodelan Benda Kerja dan Pahat

Sebelum melakukan tahap simulasi penulis
melakukan pembuatan sketsh simulasi di Autodesk
Inventor 2016 dengan mengklik tab "Get Started >
New > Metric > Standard (mm).ipt > lalu klik
create". Kemudian mulai membuat sketsh sesuai
dengan dimensi yang mengacu pada penelitian yang
telah dilakukan oleh [7] seperti ditunjukan pada
Tabel 3 di bawah ini

Tabel 3. Analysis conditions for cutting simulation

(6]

Benda Kerja
Cutting depth I mm
Cutting distance 9 mm
Workpiece length 10 mm
Rake angle 5°10° 15°
Clearance angle 12°

Pahat

Tool height 2 mm
Tool thickness 2 mm
Tool width 1 mm
Room 27°C
Temperature
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Setup Simulasi

Setelah model selesai di eksport ke Autodesk
Simulation Mechanical 2016 langkah selanjutya
pemilihan analysis type. Pemilihan analysis type ini
bertujuan untuk menentukan jenis analisis apa yang
akan digunakan. Pada kasus ini analysis type yang
dipilih adalah “Static Stress with Linear Material
Model”.

Meshing

Setelah pemilihan analysis type, model akan
terbuka pada layar Autodesk Simulation Mechanical
2016, langkah berikutnya adalah pemberian meshing
pada model. Masuk ke tab Mesh > panel Mesh >
Generate 3D Mesh, untuk membuat mesh pada
model kita. Seperti diperlihatkan pada Gambar 6
dibawah ini.

| TR s

Gambar 7. Element Material Selection

Tabel 4. Properties of Tungsten Carbide

o e [T
Gambar 6. Model yang sudah di Mesh

Setup Simulasi

Setelah mesh terbentuk, langkah berikutnya
adalah memberikan material pada setiap model. Pada
browser FEA Editor, yang terletak pada bagian
sebelah kiri layar, pilih salah satu part > material >
Klik kanan > pilih edit untuk memberikan material
pada model yang kita pilih.

Setelah mengklik edit material maka akan
terbuka layar element material selection seperti
ditunjukan pada dibawah ini. Selanjutnya klik edit
properties dan masukan nilai material properties
sesuai dengan material yang akan digunakan.
Material properties yang digunakan pada model
simulasi ini dapat dilihat pada Gambar 7

Density 19300 kg/m’
Elastic Modulus 40x10"°
Hardness 3600 Mpa

Tabel 5. Properties of Titanium Ti-6Al-4V (Ginting
2006)

Density 4430 kg/m’
Hardness 3334 Mpa
Elastic Modulus 1138x10°
Shear Strength 760n/mm’
Yield Strength (oy) 1070 N/mm?
Fatigue Strength (o) 580 N/mm’

Parameter Analisis

Langkah berikutnya adalah memberikan
parameters analysis pada simulasi. dengan mengklik
tab "Analysis type > Edit Analysis Type > Thermal >
Another Design Scenario in loaded file di Source of
Temperature > Masukkan nilai 27° di Tab Default
Temperature > Pilih Design Scenario di Use
Temperature from Design Scenario > OK. Maka
akan muncul Gambar 8.

Gambar 8. Tampilan Setelah menentukan Parameter
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Analysis

Kemudian masukkan gaya potong (F.) yang
sudah didapat di Tabel 2 dengan cara pilih bidang
yang akan diberikan gaya Klik kanan > Add >
Surface Force > Masukkan nilai F, sesuai Tabel 2>
OK

Menjalankan Simulasi

Jika sudah selesai memberikan seluruh
boundary condition dan menentukan parameters
analysis, langkah selanjutnya adalah menjalankan
analisis untuk membuat simulasi. Pada tab "4nalysis"
> panel "Analysis” > klik "Run Simulation” untuk
memulai analisis.

Hasil Simulasi

Setelah proses run simulation maka dapat kita
lihat hasil dari simulasi proses pembubutan Ti-6Al-
4V untuk melihat Tegangan pada tool berikut ini.

(b)

(c)
Gambar 9. Posisi pahat saat memotong benda kerja
(a) Geram (y) 5°, (b) Geram (y) 10° (c)
Sudut Geram (y) 15°
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Gambar 10. Perbandingan tegangan pada tiap sudut

Pembahasan

Berdasarkan  dari  perhitungan = manual
didapatkan hasil variasi Rake Angle terhadap Chip
Thickness yaitu, 1.1554 mm untuk Sudut Geram 5° ,
1.3473 mm untuk Sudut Geram 10° dan 1.5408 mm
untuk Sudut Geram 15°. Sedangkan hasil simulasi
yang didapat perbandingan tegangan untuk Rake
Angle yang berbeda selama proses pembubutan Ti-
6Al-4V  dengan kedalaman potong 1 mm
menggunakan pahat karbida menghasilkan nilai
tegangan maksimum yang berbeda yaitu 706.8593
N/mm” untuk Sudut Geram (y) 5° , 856.1114 N/mm’
untuk Sudut Geram (y) 10° dan 1368.462 N/mm?’
untuk Sudut Geram (y) 15° dimana berbanding
terbalik dengan Gaya Potong (F.) yaitu 1720.73 N
untuk Sudut Geram (y) 5°, 1590.04 N untuk Sudut
Geram (y) 10° dan 1521.172 N untuk Sudut Geram
(y) 15°, terjadi penurunan Gaya Potong (F.) untuk
setiap kenaikan Sudut Geram (y) [3,5]. Kenaikan
tegangan ini bisa karena panjang kontak antara geram
dan pahat dimana bisa berakibat kenaikan temperatur
mengakibatkan tegangan naik.

KESIMPULAN

Kesimpulan yang diperoleh dari penelitian
dan pembahasan mengenai analisa distribusi
Temperatur pahat pada proses pembubutan titanium
dengan FEM-Simulation menggunakan Sofiware
Autodesk Simulation Mechanical 2016, maka dapat
diambil kesimpulan sebagai berikut:

1. Dari perhitungan secara teoritis diketahui bahwa
gaya Potong (F.) yaitu 1720 N untuk sudut
geram () 5°, 1589 N untuk Sudut Geram (y) 10°
dan 1520 N untuk Sudut Geram (y) 15°, terjadi

penurunan Gaya Potong (F.) untuk setiap
kenaikan Sudut Geram (y).
2. Berdasarkan hasil simulasi nilai tegangan

maksimum yaitu 706.8593 N/mm® untuk Sudut
Geram (y) 5°, 856.1114 N/mm* untuk Sudut
Geram (y) 10° dan 1368.462 N/mm® untuk Sudut
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(1]

Geram (y) 15°, terjadi kenaikan tegangan untuk
setiap kenaikan Sudut Geram (y).

Perbandingan analisa gaya pada jurnal acuan dan
analisa secara teoritis mengalami perbedaan
yang tidak terlalu jauh pada proses pemesinan
Cryogenic ini. Dimana gaya pada jurnal acuan
untuk pemotongan baja karbon AISI 1045 untuk
sudut geram untuk Sudut Geram (y) 5° adalah
553 N dengan kekerasan yang lebih rendah dari
Ti-6Al1-4V [6].
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